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Welcome to TeachUcomp, Inc.’s Mastering Outlook

Made Easy tutorial. This tutorial introduces the student to

Microsoft Outlook, one of the most popular

scheduling/email programs available today. This tutorial

gives the student with little or no knowledge of Outlook a

firm skills base using Outlook.

Outlook is a terrific program to learn, as the skills

learned in Outlook can save valuable time and money by

automating, organizing and structuring the

communications, scheduling and task management

capabilities of your company.

With Outlook you can track appointments, schedule

meetings, organize notes, and send and receive email. It is

an electronic information management system that helps

you organize and share information and communicate with

others.

After learning how to use Outlook, this tutorial turns to

topics useful for legal professionals to know for using

Microsoft Outlook. It covers lessons that better inform and

educate legal professionals in the industry-specific issues

and concerns that arise from the use of Microsoft Outlook

in a legal setting. At the end of the tutorial, the student

should have a better understanding of the problems that

can arise and solutions available when using Outlook as a

legal professional.

Introduction and Overview
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Managing Tasks

21.1- Task Tracking vs. Forwarding Email:

Many times, you may have the temptation to forward an email that needs follow-up to an assistant or

colleague with some simple instructions to complete. While this is commonly done, you run the risk of

forgetting to follow-up with the individual to whom you sent the email.

A better idea is to quickly convert the email into a task and then use task assignment to manage the

task. This way you can see the email in your task list and are less likely to forget to follow-up with the person

to whom you assigned the task.

If you need to review converting an email into a task, please review lesson “18.7- Turning Emails

into Tasks” from an earlier chapter in this tutorial. In addition, if you assign the task to an individual in your

organization and your organization is using an Exchange Server, you can receive status reports on the task

to be informed when the task is marked as “completed” by the recipient. If you would like to review the

process of task assignment in an Exchange Server environment, please review “Chapter 7- Tasks” earlier in

this tutorial.

21.2- Viewing and Managing Task Times:

As you create tasks in Outlook, you often see the “Due Date” of the task appear by default. This

lesson shows you how to add a few columns of information to your Task views in Outlook to make it easy to

manage tasks and their reminders. If you find you constantly have a barrage of reminders appearing in

Outlook, showing the “Reminder Time” column in the “Tasks” view lets you easily view and change the time

at which to be reminded to complete the tasks, so you won’t need to open and edit each task individually.

To add a “Reminder Time” column to your task view in Outlook, right-click anywhere in the column

headings and then choose the “Field Chooser” command from the pop-up menu that appears. Outlook then

opens the “Field Chooser” dialog box, which shows a listing of all the available columns you can add to your

current view. Click and drag the “Reminder Time” column out of the “Field Chooser” dialog box and then

drop it into your current view to add that column. Of course, you can also add any other fields you feel would

help you to organize your tasks while the “Field Chooser” is open. After adding columns to the view, close

the “Field Chooser” dialog box.

To then edit the reminder time of a task in the task view, make the editing changes in the “Reminder

Time” column in the task view. This lets you change the value without having to individually edit the tasks or

wait until the “Reminders” window appears in Outlook.

21.3- Categorizing Tasks and Managing Views:

After you start assigning tasks, you can use the “Categorize” feature in Outlook to create custom

categories based on cases and then create custom task views to organize tasks based on case. This can be

a great way to organize your case and matter workload in Outlook.

First, create custom categories in Outlook for the cases and matters to which to assign tasks. Also,

note that you can always assign tasks and any other Outlook items to more than one category. So, you can

add case categories to any existing categorization scheme you are using and simply categorize your tasks

into whichever categories apply. If you need to review how to create new categories, review lesson “2.7-

Categorizing Contacts” in an earlier chapter of this tutorial. This time, however, you are creating categories

for cases and then assigning tasks to the case categories you create.

After creating the case and matter categories, then categorize your tasks using the case categories

you created. Once that is finished, you can then customize the view of your task folder to show the tasks
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Managing Tasks

21.3- Categorizing Tasks and Managing Views:

grouped by category to organize the view of your workload by case/matter.

To create a custom view of the task folder in Outlook organized by category, click the “View” tab in

the Ribbon. Then click the “Change View” button in the “Current View” button group. Then select the

“Manage Views…” command from the drop-down menu that appears.

In the “Manage All Views” dialog box that then opens, click the “New…” button to the right. Type a

name for the new view into the “Name of new view” field. Name it something like “Tasks by Case” to help

you easily find and apply the view later. Next, select “Table” from the “Type of view” list. Below that, select

who has this view available to them: “This folder, visible to everyone,” “This folder, visible only to me,” or “All

Task folders.” Then click the “OK” button to open the “Advanced View Settings” dialog box, where you can

further customize the view.

Click the “Columns…” button in the “Advanced View Settings” dialog box to then open the “Show

Columns” dialog box. Here, use the drop-down in the upper-left corner to choose which set of fields to show

in the left list. To move an available field into your new view, select it in the left list and then click the “Add”

button in the middle of this dialog box to add it to the right list. It is recommended to add the fields for “Start

date,” “Due date” and “Categories” for this view, although “Due Date” and “Categories” should appear in the

view, by default. To reorganize a column’s position in the right list, click it to select it. Then click the “Move

Up” and “Move Down” buttons below the list until it is in the place you want. Then click the “OK” button after

adding and organizing the fields in your view.

To group the items in the view by category, click the “Group By…” button to open the “Group By”

dialog box. Here, use the drop-down under “Group items by” to select the “Categories” field. Then set

whether to sort the group in “Ascending” (A-Z, 1-9) order or “Descending” (Z-A, 9-1) order by selecting the

desired option button at the right end of the field. If desired, you can create further groups by repeating this

process for the following “Then by” fields. You can create grouping by up to three fields, if needed. When

finished, click the “OK” button to set the grouping for your view.

To sort the items in the groups, click the “Sort…” button to open the “Sort” dialog box. Here you can

use the drop-down available under the “Sort items by” and “Then by” sections to indicate by which field(s) to

sort the view. You can sort by up to four fields, and they can be sorted in either “Ascending” order or

“Descending” order by selecting the desired option button at the right end of each field. You should select

fields for sorting that help you see the most urgent tasks to complete at the top of each case category.

Popular choices include “Start Date,” “Due Date,” and “Priority.” Remember to also select a sort order for

any fields you choose. When finished, click the “OK” button to set the view’s sorting.

At this point, you should have a view that lets you see tasks grouped by category (case) and sorts

the tasks in each group by your desired field priorities. When you are satisfied with the view’s settings, click

the “OK” button in the “Advanced View Settings” dialog box to return to the “Manage All Views” dialog box.

The name of your new view appears in the list of views in the “Manage All Views” dialog box. To

apply your view, click its name to select it from the list, and then click the “Apply View” button at the bottom

of the dialog box. Another way to apply the view is to select the name of the custom view that appears in the

“Current View” button group on the “Home” tab of the Ribbon.

To later modify the view you created, select the name of the view from the listing in the “Manage All

Views” dialog box and then click the “Modify…” button at the right side of the dialog box. Then make the

changes you want and save the changes to the view. To delete the custom view if you no longer need it,

select the name of the custom view you created from the listing in the “Manage All Views” dialog box and

then click the “Delete” button at the right side of the dialog box. Then click the “Yes” button in the deletion

confirmation message box that appears to finish deleting it. When you finish using the “Manage All Views”

dialog box, click the “Close” button to close it.
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ACTIONS-

Managing Tasks

TASK TRACKING VS. FORWARDING EMAIL:

1. Instead of forwarding an email that needs follow-up to someone else, convert the email into a task and 

then use task assignment to manage the task.

2. If you need to review converting an email into a task, please review lesson “18.7- Turning Emails into 

Tasks” from an earlier chapter in this tutorial.

3. If you assign the task to an individual in your organization and your organization is using Exchange 

Server, you can receive status reports on the task to be informed when the task is marked as 

“completed” by the recipient. 

4. If you would like to review the process of task assignment in an Exchange Server environment, please 

review “Chapter 7- Tasks” earlier in this tutorial.

VIEWING AND MANAGING TASK TIMES:

1. To add a “Reminder Time” column to your task view in Outlook, right-click anywhere in the column 

headings and then choose the “Field Chooser” command from the pop-up menu that appears.

2. Outlook then opens the “Field Chooser” dialog box, which shows a listing of all the available columns 

you can add to your current view.

3. Click and drag the “Reminder Time” column out of the “Field Chooser” dialog box and then drop it into 

your current view to add that column.

4. Of course, you can also add any other fields you feel would help you to organize your tasks while the 

“Field Chooser” is open. 

5. After adding columns to the view, close the “Field Chooser” dialog box.

6. To then edit the reminder time of a task in the task view, make the editing changes in the “Reminder 

Time” column in the task view. This lets you change the value without having to individually edit the 

tasks or wait until the “Reminders” window appears in Outlook.

CATEGORIZING TASKS AND MANAGING VIEWS:

1. First, create custom categories in Outlook for the cases and matters to which to assign tasks.

2. Note that you can always assign tasks and any other Outlook items to more than one category. So, you 

can add case categories to any existing categorization scheme you are using and simply categorize 

your tasks into whichever categories apply.

3. If you need to review how to create new categories, review lesson “2.7- Categorizing Contacts” in an 

earlier chapter of this tutorial. This time, however, you are creating categories for cases and then 

assigning tasks to the case categories you create.

4. After creating the case and matter categories, then categorize your tasks using the case categories you 

created.

5. Once that is finished, you can then customize the view of your task folder to show the tasks grouped by 

category to organize the view of your workload by case/matter.

6. To create a custom view of the task folder in Outlook organized by category, click the “View” tab in 

the Ribbon. Then click the “Change View” button in the “Current View” button group.

7. Then select the “Manage Views…” command from the drop-down menu that appears. 

8. In the “Manage All Views” dialog box that then opens, click the “New…” button to the right.

9. Type a name for the new view into the “Name of new view” field.

(cont’d.)
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ACTIONS-

Managing Tasks

CATEGORIZING TASKS AND MANAGING VIEWS- (CONT’D.):

10. Next, select “Table” from the “Type of view” list.

11. Below that, select who has this view available to them: “This folder, visible to everyone,” “This folder, 

visible only to me,” or “All Task folders.”

12. Then click the “OK” button to open the “Advanced View Settings” dialog box.

13. Click the “Columns…” button in the “Advanced View Settings” dialog box to then open the “Show 

Columns” dialog box.

14. Here, use the drop-down in the upper-left corner to choose which set of fields to show in the left list.

15. To move an available field into your new view, select it in the left list and then click the “Add” button 

in the middle of this dialog box to add it to the right list.

16. It is recommended to add the fields for “Start date,” “Due date” and “Categories” for this view, although 

“Due Date” and “Categories” should appear in the view, by default.

17. To reorganize a column’s position in the right list, click it to select it.

18. Then click the “Move Up” and “Move Down” buttons below the list until it is in the place you want.

19. Then click the “OK” button after adding and organizing the fields in your view.

20. To group the items in the view by category, click the “Group By…” button to open the “Group By” 

dialog box.

21. Here, use the drop-down under “Group items by” to select the “Categories” field.

22. Then set whether to sort the group in “Ascending” (A-Z, 1-9) order or “Descending” (Z-A, 9-1) order by 

selecting the desired option button at the right end of the field.

23. If desired, you can create further groups by repeating this process for the following “Then by” fields. You 

can create grouping by up to three fields, if needed.

24. When finished, click the “OK” button to set the grouping for your view.

25. To sort the items in the groups, click the “Sort…” button to open the “Sort” dialog box.

26. Here you can use the drop-down available under the “Sort items by” and “Then by” sections to indicate 

by which field(s) to sort the view.

27. You can sort by up to four fields, and they can be sorted in either “Ascending” order or “Descending” 

order by selecting the desired option button at the right end of each field.

28. You should select fields for sorting that help you see the most urgent tasks to complete at the top of 

each case category. Popular choices include “Start Date,” “Due Date,” and “Priority.”

29. Remember to also select a sort order for any fields you choose.

30. When finished, click the “OK” button to set the view’s sorting.

31. At this point, you should have a view that lets you see tasks grouped by category (case) and sorts the 

tasks in each group by your desired field priorities.

32. When satisfied with the view’s settings, click the “OK” button in the “Advanced View Settings” dialog box 

to return to the “Manage All Views” dialog box.

33. The name of your new view appears in the list of views in the “Manage All Views” dialog box.

34. To apply your view, click its name to select it from the list, and then click the “Apply View” button at the 

bottom of the dialog box.

35. Alternatively, to apply the view, select the name of the custom view that appears in the “Current View” 

button group on the “Home” tab of the Ribbon. 

36. To later modify the view you created, select the name of the view from the listing in the “Manage All 

Views” dialog box and then click the “Modify…” button at the right side of the dialog box.

37. Then make the changes you want and save the changes to the view.

(cont’d.)
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ACTIONS-

Managing Tasks

CATEGORIZING TASKS AND MANAGING VIEWS- (CONT’D.):

38. To delete the custom view if you no longer need it, select the name of the custom view you created 

from the listing in the “Manage All Views” dialog box and then click the “Delete” button at the right side 

of the dialog box.

39. Then click the “Yes” button in the deletion confirmation message box that appears to finish deleting it.

40. When you finish using the “Manage All Views” dialog box, click the “Close” button to close it.
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EXERCISES-

Managing Tasks

Purpose:

1. To create a custom view that arranges tasks by category, start date, and due date.

Exercises:

1. Open Outlook and then click the “Tasks” icon in the Navigation Bar to open the Tasks view.

2. Then click to select the “Tasks” folder in the Folder Pane at the left side of the window.

3. Click the “View” tab in the Ribbon.

4. Then click the “Change View” button in the “Current View” button group.

5. Select the “Manage Views…” command from the button’s drop-down menu.

6. The “Manage All Views” dialog box then opens. 

7. Click the “New…” button to the right of this dialog box.

8. Type “Tasks by Case” into the “Name” field in the “Create a new view:” dialog box.

9. Next, select “Table” from the “Type of view” list.

10. Below that, select who will have this view available to them: “This folder, visible to everyone,” “This 

folder, visible only to me,” or “All Task folders.”

11. Click the “OK” button to open the “Advanced View Settings” dialog box, where you can further 

customize the view.

12. Click the “Columns…” button in the “Advanced View Settings” dialog box to open the “Columns” dialog 

box.

13. Click to select the “Start Date” field in the left list, called the “Available fields” list.

14. Then click the “Add ->” button to add it to the right list, called the “Show these columns in this order list.”

15. With the “Start Date” field still selected in the right list, repeatedly click the “Move Up” button until the 

“Start Date” field appears above the “Due Date” field in the right list.

16. Then click the “OK” button in the “Columns” dialog box.

17. Click the “Group By…” button in the “Advanced View Settings” dialog box to open the “Group By” dialog 

box.

18. Select “Categories” from the “Group items by” drop-down.

19. Then select the desired sort order for the groups created by the “Categories” field by choosing either the 

“Ascending” or “Descending” option button.

20. Then click the “OK” button to set the grouping for your view.

21. Click the “Sort…” button in the “Advanced View Settings” dialog box to open the “Sort” dialog box.

22. Use the drop-down under “Sort items by” to select “Start Date.”

23. Use the drop-down under “Then by” to select “Due Date.”

24. Click the “OK” button in the “Sort” dialog box to set the sorting for your view.

25. Click “OK” in the “Advanced View Settings” dialog box to return to the “Manage All Views” dialog box.

26. Apply your new view by clicking its name to select it and then clicking the “Apply View” button at the 

bottom of the dialog box.

27. Click the “Close” button at the bottom of the dialog box to close it.

28. To reset the view to its default “Simple List” view, click the “Change View” drop-down button in the 

“Current View” button group on the “View” tba of the Ribbon and then select the “Simple List” choice in 

the drop-down menu that appears.
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